Release Notes

IBM® Rational® Rhapsody® Automatic Test Generation Add On

Version 3.8.1

BTC Embedded Systems AG
Gerhard-Stalling-Straße 19
26135 Oldenburg
+49 441 969738 0 (voice)
+49 441 969738 64 (fax)

Tool Identification:
IBM® Rational® Rhapsody® Automatic Test Generation Add On --- Release 3.8.1 build 3937 for Rhapsody 8.1.1

Media Identification
CD-ROM:
Rhapsody ATG 3.8.1
Windows XP SP3, Windows Vista SP2, Windows 7
License Agreement

No part of this publication may be reproduced, transmitted, stored in a retrieval system, nor translated into any human or computer language, in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual or otherwise, without the prior written permission of the copyright owner, BTC Embedded Systems AG.

The information in this publication is subject to change without notice, and BTC Embedded Systems AG assumes no responsibility for any errors which may appear herein. No warranties, either expressed or implied, are made regarding Rhapsody software including documentation and its fitness for any particular purpose.

Trademarks

IBM® Rational® Rhapsody®, IBM® Rational® Rhapsody® Automatic Test Generation Add On, and IBM® Rational® Rhapsody® TestConductor Add On are registered trademarks of IBM Corporation.

All other product or company names mentioned herein may be trademarks or registered trademarks of their respective owners.

© Copyright 2003-2014 BTC Embedded Systems AG. All rights reserved.
Contacting IBM® Rational® Software Support


For contact information and guidelines or reference materials that you need for support, read the IBM Software Support Handbook.

For Rational software product news, events, and other information, visit the IBM Rational Software Web site.

Voice support is available to all current contract holders by dialing a telephone number in your country (where available). For specific country phone numbers, go to http://www.ibm.com/planetwide.

Before you contact IBM Rational Software Support, gather the background information that you will need to describe your problem. When describing a problem to an IBM software support specialist, be as specific as possible and include all relevant background information so that the specialist can help you solve the problem efficiently. To save time, know the answers to these questions:

- What software versions were you running when the problem occurred?
- Do you have logs, traces, or messages that are related to the problem?
- Can you reproduce the problem? If so, what steps do you take to reproduce it?
- Is there a workaround for the problem? If so, be prepared to describe the workaround.
## Contents

1. IBM® Rational® Rhapsody® Automatic Test Generation Add On Product Capabilities ............................................................... 6
2. What's New in version 3.8.1 build 3937 ........................................................................................................................................ 6
3. What's New in version 3.8.0 build 3827 ........................................................................................................................................ 6
4. What's New in version 3.7.6 build 3730 ........................................................................................................................................ 7
5. What's New in version 3.7.5 build 3645 ........................................................................................................................................ 7
6. What's New in version 3.7.4 build 3511 ........................................................................................................................................ 7
7. What's New in version 3.7.3 build 3450 ........................................................................................................................................ 8
8. What's New in version 3.7.2 build 3238 ........................................................................................................................................ 8
9. What's New in version 3.7.0 build 3115 ........................................................................................................................................ 8
10. What's New in version 3.7.0 build 3088 ........................................................................................................................................ 8
11. What's New in version 3.6.5 build 2931 ........................................................................................................................................ 9
12. What's New in version 3.6.5 build 2834 ........................................................................................................................................ 9
13. What's New in version 3.6.4 build 2535 ........................................................................................................................................ 9
14. What's New in version 3.6.4 build 2497 ........................................................................................................................................ 9
15. What's New in version 3.6.3 build 2208 ........................................................................................................................................ 10
16. What's New in version 3.6.3 build 2169 ........................................................................................................................................ 10
17. What's New in version 3.6.2 build 1912 ........................................................................................................................................ 10
18. What's New in version 3.6.2 build 1887 ........................................................................................................................................ 10
19. What's New in version 3.6.1 build 1545 ........................................................................................................................................ 11
20. What's New in version 3.6 build 1434 ......................................................................................................................................... 11
21. What's New in version 3.6 build 1411 ......................................................................................................................................... 11
22. What's New in version 3.5 build 1057 ......................................................................................................................................... 12
23. What's New in version 3.5 build 1019 ......................................................................................................................................... 12
24. What's New in version 3.4 build 954 ......................................................................................................................................... 12
25. What's New in version 3.4 build 918 ......................................................................................................................................... 12
26. What's New in version 3.3 build 878 ......................................................................................................................................... 13
27. What's New in version 3.3 build 847 ......................................................................................................................................... 13
28. What's New in v3.2 build 719 ......................................................................................................................................................... 13
29. What's New in v3.2 build 693 ......................................................................................................................................................... 14
30. What's New in v3.2 build 665 ......................................................................................................................................................... 14
31. What's New in v3.2 build 641 ......................................................................................................................................................... 14
32. What's New in v3.1 build 560 ......................................................................................................................................................... 15
33. What's New in v3.1 build 553 ......................................................................................................................................................... 15
34. What's New in v3.1 build 536 ......................................................................................................................................................... 16
35. What's New in v3.0 build 429 ......................................................................................................................................................... 17
36. What's New in v3.0 build 422 ......................................................................................................................................................... 17
37. What's New in v2.3 build 282 ......................................................................................................................................................... 18
38. What's New in v2.3 build 272 ......................................................................................................................................................... 18
39. What's New in v2.3 build 266 ......................................................................................................................................................... 19
40. What's New in v2.3 build 243 ......................................................................................................................................................... 19
41. What's New in v2.3 build 213 ......................................................................................................................................................... 20
42. What's New in v2.2 build 176 ......................................................................................................................................................... 20
43. What's New in v2.2 build 160 ......................................................................................................................................................... 21
44. What's New in v2.1 build 148 ......................................................................................................................................................... 21
45. What's New in v2.1 build 117 ......................................................................................................................................................... 22
46. What's New in v2.1 build 109 ......................................................................................................................................................... 23
47. What's New in v2.1 build 108 ......................................................................................................................................................... 23
48. What's New in v2.1 build 98 ......................................................................................................................................................... 23
49. What's New in v2.1 build 86 ......................................................................................................................................................... 23
50. What's New in v2.1 build 79 ......................................................................................................................................................... 24
51. What's New in v2.0 build 74 ......................................................................................................................................................... 24
52. What's New in v2.0 build 68 ......................................................................................................................................................... 24
53. What's New in v2.0 build 67 ......................................................................................................................................................... 24
54. What's New in v2.0 build 66 ......................................................................................................................................................... 24
55. What's New in v2.0 build 63 ......................................................................................................................................................... 25
56. What's New in v1.5 build 39 ......................................................................................................................................................... 25
57. What's New in v1.1 build 27 ......................................................................................................................................................... 25
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>58</td>
<td>What's New in v1.0 build 20...</td>
<td>26</td>
</tr>
<tr>
<td>59</td>
<td>What's New in v1.0 build 19...</td>
<td>26</td>
</tr>
<tr>
<td>60</td>
<td>What's New in v1.0...</td>
<td>26</td>
</tr>
<tr>
<td>61</td>
<td>Documentation:</td>
<td>26</td>
</tr>
<tr>
<td>62</td>
<td>Samples...</td>
<td>27</td>
</tr>
<tr>
<td>63</td>
<td>Supported Platforms and Hardware/Software Requirements</td>
<td>27</td>
</tr>
<tr>
<td>64</td>
<td>Hardware/Software Requirements:</td>
<td>27</td>
</tr>
<tr>
<td>65</td>
<td>Supported Rhapsody Version...</td>
<td>27</td>
</tr>
<tr>
<td>66</td>
<td>Training...</td>
<td>27</td>
</tr>
</tbody>
</table>
1 IBM® Rational® Rhapsody® Automatic Test Generation Add On

Product Capabilities

Rhapsody ATG supports automatic test generation for UML/SysML models developed with RhapsodyC++. ATG analyzes a model and generates test vectors which can be used for final testing. ATG 3.8.1 generates test vectors in order to reach all statechart states, transitions, operations, and events of the reactive classes in an examined model.

2 What's New in version 3.8.1 build 3937

- New Features in 3.8.1 build 3937:
  - Summarized requirement coverage: Option to generate information about the combined requirement coverage for multiple sequence diagrams generated by ATG.

- Enhancements in 3.8.1 build 3937:
  - Support of Cygwin g++: ATG supports generation of traces when using C++ Cygwin environment (32 bit).
  - New ATG user guide. A new user guide for the ATG add on has been added to the installation.
  - Report generation with Rational Publishing Engine: ATG provides a template for generating requirement coverage reports.

- Bug Fixes in 3.8.1 build 3937:
  - 234682: DFT Rhapsody 806 The labels in Test Generation Configuration of ATG cannot be seen completely

3 What's New in version 3.8.0 build 3827

- New Features in 3.8.0 build 3827:
  - None

- Enhancements in 3.8.0 build 3827:
  - Improved selection of input interface: ATG offers to auto select the input interface of the SUT either for direct stimulation of the SUT or for stimulation using its port interface.

- Bug Fixes in 3.8.0 build 3827:
  - None
4 What's New in version 3.7.6 build 3730

• New Features in 3.7.6 build 3730:
  None
• Enhancements in 3.7.6 build 3730:
  • Improved documentation capabilities of requirements coverage: When exporting test cases, ATG optionally adds test objectives from the test cases to requirements, allowing to generate TestConductor test requirements coverage reports.
• Bug Fixes in 3.7.6 build 3730:
  None

5 What's New in version 3.7.5 build 3645

• New Features in 3.7.5 build 3645:
  • Option to add dependencies from exported traces to requirements, allowing to create requirement coverage reports.
• Enhancements in 3.7.5 build 3645:
  • Rhapsody ATG supports Microsoft VS 2010 development environment.
  • Support of flow ports when generating traces and exporting traces to sequence diagrams or test cases.
  • Improved support of enum types: The input interface can be defined using enum literals and traces are exported to sequence diagrams or test cases with enum literals instead of integer numbers.
• Bug Fixes in 3.7.5 build 3645:
  None

6 What's New in version 3.7.4 build 3511

• New Features in 3.7.4 build 3511:
  None
• Enhancements in 3.7.4 build 3511:
  None
• Bug Fixes in 3.7.4 build 3511:
  None
7 What's New in version 3.7.3 build 3450

- New Features in 3.7.3 build 3450: None
- Enhancements in 3.7.3 build 3450:
  - Rhapsody Automatic Test Generation Add On is available as native 64 bit dll.
  - Bug Fixes in 3.7.3 build 3450: None

8 What's New in version 3.7.2 build 3238

- New Features in 3.7.2 build 3238: None
- Enhancements in 3.7.2 build 3238:
  - New ATG tutorial: A new, separate ATG tutorial and sample model have been added to the installation.
  - Bug Fixes in 3.7.2 build 3238: None

9 What's New in version 3.7.0 build 3115

- New Features in 3.7.0 build 3115: None
- Enhancements in 3.7.0 build 3115:
  - Aligning ATG framework with Rhapsody 8.0 OXF framework: Improved support of features and functionality of the Rhapsody 8.0 OXF framework.
  - New ATG tutorial: A new, separate ATG tutorial and sample model have been added to the installation.
  - Bug Fixes in 3.7.0 build 3115: None

10 What's New in version 3.7.0 build 3088

- New Features in 3.7.0 build 3088: None
- Enhancements in 3.7.0 build 3088: None
• Bug Fixes in 3.7.0 build 3088:
  None

11 What's New in version 3.6.5 build 2931

• New Features in 3.6.5 build 2931:
  None
• Enhancements in 3.6.5 build 2931:
  None
• Bug Fixes in 3.6.5 build 2931:
  185363: After operation 'Export Test Cases to Rhapsody' test case updating leads to error 'Failed to create operation ...tempOperationCreatedByTestConductor_0'

12 What's New in version 3.6.5 build 2834

• New Features in 3.6.5 build 2834:
  None
• Enhancements in 3.6.5 build 2834:
  None
• Bug Fixes in 3.6.5 build 2834:
  None

13 What's New in version 3.6.4 build 2535

• New Features in 3.6.4 build 2535:
  None
• Enhancements in 3.6.4 build 2535:
  None
• Bug Fixes in 3.6.4 build 2535:
  None

14 What's New in version 3.6.4 build 2497

• New Features in 3.6.4 build 2497:
  None
• Enhancements in 3.6.4 build 2497: None
• Bug Fixes in 3.6.4 build 2497:
  141982: Architect: ATG: Non clear message. Inconsistency with Rhapsody Developer
  142607: Automatic Test Generation dialog - 'Model Element Coverage' is not translated

15 What's New in version 3.6.3 build 2208
----------------------------------------------
• New Features in 3.6.3 build 2208: None
• Enhancements in 3.6.3 build 2208: None
• Bug Fixes in 3.6.3 build 2208: None

16 What's New in version 3.6.3 build 2169
----------------------------------------------
• New Features in 3.6.3 build 2169: None
• Enhancements in 3.6.3 build 2169: None
• Bug Fixes in 3.6.3 build 2169: None

17 What's New in version 3.6.2 build 1912
----------------------------------------------
• New Features in 3.6.2 build 1912: None
• Enhancements in 3.6.2 build 1912: None
• Bug Fixes in 3.6.2 build 1912: None

18 What's New in version 3.6.2 build 1887
----------------------------------------------
• New Features in 3.6.2 build 1887: None
• Enhancements in 3.6.2 build 1887: Incremental export of missing test cases
• Bug Fixes in 3.6.2 build 1887: 17109: Re-exporting test cases from ATG into Rhapsody leads to creation of empty code-assert-testcases

19 What's New in version 3.6.1 build 1545

• New Features in 3.6.1 build 1545: ATG support for Visual Studio 2008
• Enhancements in 3.6.1 build 1545: None
• Bug Fixes in 3.6.1 build 1545: Note: The listed numbers refer to Rhapsody TeamConcert Work Items
  124464: Rhapsody 7.5 ATG Config. error msg:Cannot find VcVars32_6.bat

20 What's New in version 3.6 build 1434

• New Features in 3.6 build 1434: None
• Enhancements in 3.6 build 1434: None
• Bug Fixes in 3.6 build 1434: None

21 What's New in version 3.6 build 1411

• New Features in 3.6 build 1411: None
• Enhancements in 3.6 build 1411: None
• Bug Fixes in 3.6 build 1411: Note: The listed numbers refer to Quintus entries
  217692 Correct comment in sample Atg\TheVendingMachineStart
22 What's New in version 3.5 build 1057

- New Features in 3.5 build 1057: None
- Enhancements in 3.5 build 1057: None
- Bug Fixes in 3.5 build 1057: 218408 copyright strings with Telelogic and i-Logix still appear under atg folder

23 What's New in version 3.5 build 1019

- New Features in 3.5 build 1019: None
- Enhancements in 3.5 build 1019: None
- Bug Fixes in 3.5 build 1019: 106615 ATG not correctly working with FlowPorts

24 What's New in version 3.4 build 954

- New Features in 3.4 build 954: None
- Enhancements in 3.4 build 954: None
- Bug Fixes in 3.4 build 954: None

25 What's New in version 3.4 build 918

- New Features in 3.4 build 918:
  - ATG support of Advanced Code Generator
  - ATG support of Visual Studio 2005
- Enhancements in 3.4 build 918: None
• Bug Fixes in 3.4 build 918:
  214784 Request to have ATG support for VS 2005
  210788 ATG should work with advanced CG
  97913 No support of Visual Studio .Net 2005 for ATG

26 What's New in version 3.3 build 878

• New Features in 3.3 build 878:
  None
• Enhancements in 3.3 build 878:
  None
• Bug Fixes in 3.3 build 878:
  None

27 What's New in version 3.3 build 847

• New Features in 3.3 build 847:
  None
• Enhancements in 3.3 build 847:
  None
• Bug Fixes in 3.3 build 847:
  105990 Defect: Test Conductor requires path to directory above share...cannot move OMROOT
  100850 ATG4Rhap.ini
  101921 ATG documentation not up-to-date

28 What's New in v3.2 build 719

• New Features in v3.2 build 719:
  None
• Enhancements in v3.2 build 719:
  None
• Bug Fixes in v3.2 build 719:
  None
29 What's New in v3.2 build 693

• New Features in v3.2 build 693:
  None
• Enhancements in v3.2 build 693:
  None
• Bug Fixes in v3.2 build 693:
  105817 ATG: get a strange ATG error when I open the Radio model

30 What's New in v3.2 build 665

• New Features in v3.2 build 665:
  None
• Enhancements in v3.2 build 665:
  None
• Bug Fixes in v3.2 build 665:
  104034 Upgrade OSC Testing products to license RC2
  85498 Insufficient coverage of if statements
  76859 Unit ATG: ATG compiler doesn't pay attention to Files inside a Component

31 What's New in v3.2 build 641

• New Features in v3.2 build 641:
  • Model based test design based on UML Testing Profile
    • Model based design of test architectures
    • Model based design of test cases
  • Automatic and manual creation of test architectures using TestConductor
  • Automatic definition of interfaces and coverage goals reusing information from test architectures
  • Ability to generate unit tests, integration tests and system tests facilitated by test architectures
  • Export to model level test cases
  • Possibility to export both test cases containing only inputs and test cases containing inputs and outputs
• Enhancements in v3.2 build 641:
  • Possibility to use original oxf framework instead of proprietary atg framework allows test case generation for a larger class of models
• Bug Fixes in v3.2 build 641:
  102893 TheVendingMachine description is actually in "ATG User Guide" (NOT in "ATG tutorial")
  101062 Citrix: ATG creates temporary files in the ROOT's temp directory, which is bad for Citrix
  100531 ATG: Impossible to generate test cases
  99637 TestConductor: select TestContext and then"Generate TestCases" - ATG suspends
  99634 TestConductor: select TestContext and select "Generate TestCases"... oops ... fatal error takes place
  97879 RhapATG.dll fail to load
  97981 Space in path:RATG - cannot generate test cases if we install Rhapsody into folder with spaces in its path
  95639 ATG_Tutorial.pdf and ATG_User_Guide.pdf are identical
  84697 Multiple Arguments on Events not Supported
  80905 ATG does not work properly for Model level analysis and coverage

32 What's New in v3.1 build 560

• New Features in v3.1build 560:
  None
• Enhancements in v3.1build 560:
  None
• Bug Fixes in v3.1build 560:
  None

33 What's New in v3.1 build 553

• New Features in v3.1build 553:
  None
• Enhancements in v3.1build 553:
  None
• Bug Fixes in v3.1build 553:
  95635 Misspelling in ATG_Release_Notes.pdf: "Handling of timeout handling
  95629 ATG_Tutorial.pdf: check figure 12 on page 20 - this figure shows us component with stereotype "atgComponent"
  80149 ATG cannot handle inline operations
34 What's New in v3.1 build 536

---

- New Features in v3.1 build 536:
  - ATG provides a browser view for model coverage and code coverage
  - to review the covered and not covered model elements (states, transitions, operations, events)
  - to review the covered and not covered code parts (statements coverage and MCDC coverage)
  - to review the generated test cases for model coverage and code coverage
  - to have traceability between covered code parts and generated test cases
  - the browser view and the other windows are now realized by a splitter window allowing users to re-size the windows
  - users can generate reports (XML/HTML) with all relevant details
  - test cases can be exported to XML representation of input and output sequences
  - Test Definition Options to control and optimise the test case generation algorithm
    - Search options: breadth-first-search and beam-search (stream-search)
    - Handling of timeouts: accurate vs. pre-defined time-steps

- Enhancements in v3.1 build 536:
  - Support for C-standard library functions and C++-standard library functions for Visual Studio 6.0 compilation environment
  - Improved support for C-standard library functions and C++-standard library functions for .NET2003 compilation environment

- Bug Fixes in v3.1 build 536:
  - 94473 RhapATG error on reopen a model.
  - 94154 There is German pagination in file ATG_Release_Notes.pdf (like Seite 3/14)
  - 94153 ATG_Release_Notes.pdf: misspelling - VS60 should be replaced into VC60
  - 94152 Invoke RATG from Rhapsody-in-C ... missing message "RATG is available only for RiC++"
  - 93828 Automatic Test Generation form - press button "Hide Details": form buttons are cutted
  - 93360 Installation of RATG fails - "Rhapsody Pisces installation not found..."
  - 93044 "RATG main pulldown menu items "Export to TBrun", "Export to Cantata++" should be"
  - 93043 "Check RATG browser popup menu: missing items ""Export to TBrun"", ""Export to Cantata++" should be"
  - 92604 "Error about ""Synchronization of ATG Data"" appears on Generation-Test-Cases"
  - 90040 An error message appears on generate testcases
  - 89355 "RATG/Export to ASCII: message appears ""One or more files seem to exist. Overwrit"
  - 89178 RATG/export test cases to TBrun - behavioural change was detected
  - 89177 RATG - export test cases to Cantata++ fails
  - 88227 ATG samples must be in new ATG data format and habe broken UI
87898 ATG must stop before all available memory gets consumed
87895 All generated sequence diagrams start with a delay of 300s !!!!
86803 "RATG - irrelevant item ""Help Topics"" in popup menu "
86802 "RATG - pulldown menu item ""Help;Help Topics"" is disabled. Is this a bug ? "
85579 UnitATG: Void operation seem to return values in exported test cases
85544 UnitATG: Test generation fails without giving useful info
85490 UnitATG: Opening a model twice may result in corruption of ATG data
85392 UnitATG: errors occured while processing unit
84699 Unit ATG: timeouts for unit tests
82677 Unit ATG: Sample Atg\Adms4Atg should be corrected
82643 Unit ATG: Atg\Adms4Atg sample - warning on build SMS_SUB_SYSTEM::Debug component
82244 Unit ATG: When running tests generated for Cantata++ via ATG, the tests never end
82240 Unit ATG: Generated code doesn't compile
82239 "Unit ATG: When exporting to Cantata++, message ""Export to Cantata++ finished"" is "
80387 ATG shall support graceful termination
77622 cannot perform a Unit test on a class because it does not appear anywhere in ATG
72839 Unit ATG: Code Generation dialog comes up every time you generate tests

• Changes in v3.1build b536:
  Export to Cantata++ and to Testbed/TBrun has been removed.

35 What's New in v3.0 build 429

• New Features in v3.0 build 429:
  Split window between browser and tab section
  • Enhancements in v3.0 build 429:
    None
  • Bug Fixes in v3.0 build 429:
    None

36 What's New in v3.0 build 422

• New Features in v3.0 build 422:
  • Test Definition Options (new dialog on ATG-Configurations)
    • to switch between “Breadth First” and “Beam” search
    • to handle timeouts more efficiently
  • Enhancements in v3.0 build 422:
    • .NET2003 partially supported (but not fully tested)
• ASCII export replaced by XML export
• New options in Settings Dialog
• MCDC and statement coverage computation based only on code that belongs to explicitly represented model elements.
• Conversion mechanism of ATG2.3 Data

• Bug Fixes in v3.0 build 422:
  72839 Code Generation dialog comes up every time you generate tests
  80121 All ATG GUI tabs should be updated when syncing with model
  80387 ATG shall support graceful termination
  84695 Test results not updated
  84696 Deleting a Configuration Takes Too Long
  84698 Event Argument Values Not Accepted (Not a bug)
  84710 Crash during load without subunits
  84728 Partial Loading causes Crash
  84758 crash when opening model with no sub-units
  85026 About RhapsodyAtgATG release Notes.pdf
  85279 Installation of RATG fails
  86824 RTC/ATG - files "silentMode.log" should be deleted from installation files list
  87206 Bugs 82677, 82643 are not fixed - they should be removed from the"Bug Fixes in v2.3 build 266"
  87270 Configurations order in RATG tree should be alphabetical
  87898 ATG must stop before all available memory gets consumed
  88224 Diagrams in samples are corrupted and format properties not updated

37 What's New in v2.3 build 282

• New Features in v2.3 build 282:
  None
• Enhancements in v2.3 build 282:
  None
• Bug Fixes in v2.3 build 282:
  88747 Sample Adms4Atg/testcase classStation:summary of execution contains errors

38 What's New in v2.3 build 272

• New Features in v2.3 build 272:
  None.
• Enhancements in v2.3 build 272:
Old ATG program files and samples are deleted before installing a new version.  

**Note:** Changes in the ATG samples folder will be overwritten.

- Bug Fixes in v2.3 build 272:
  - 82643 Atg\Adms4Atg sample - warning on build SMS_SUB_SYSTEM::Debug component takes place
  - 82677 ATG Unit ATG: Sample Atg\Adms4Atg should be corrected
  - 87206 Bugs 82677, 82643 are not fixed - they should be removed from the "Bug Fixes in v2.3 build 266"

### 39 What's New in v2.3 build 266

- New Features in v2.3 build 266:
  None
- Enhancements in v2.3 build 266:
  None
- Bug Fixes in v2.3 build 266:
  - 80405 ATG Tutorial and User Guide - missing bookmarks in .pdf files
  - 82635 ATG sample Rhapsody\Samples\CppSamples\Atg\TheVendingMachineStart – few problems detected
  - 82636 Documentation of RATG, page 34, figure 27, "Test Goal Coverage" group - has only one progressor
  - 82638 Tutorial of RATG, page 43, "2. Open the Testing ... and select the test goal: Water_out ..."
  - 82640 Tutorial of RATG, page 51-52, "The function int get_amount(int p) is used ..."
  - 82642 Model Atg\Pbx4Atg has event with default name "event_1904"
  - 84695 Test results not updated
  - 85019 If create and build ATG::Default configuration in sample TheVendingMachine - build warnings take place
  - 85020 RATG tutorial - a little problem was detected
  - 85119 Do not load profiles until they are needed
  - 85279 Installation of RATG fails
  - 85720 Rhapsody ATG is not allowed to run in Systems Designer
  - 85784 RATG: error arises on generate test cases
  - 85788 Window "Rhapsody ATG" arises with message "Unable to create the specified directory"
  - 85854 Check RATG's main pulldown menu Tools->Export items - item "TestConductor" is disabled
  - 86804 ATG_Tutorial.pdf - mess in figures numbering
  - 87054 RATG: "unknown error" on export test cases to TBrunt, Cantata++

### 40 What's New in v2.3 build 243

ATG_Release_Notes.odt
• New Features in v2.3 build 243:
  ATG supports export of test cases into the Cantata++ (IPL) format.
• Enhancements in v2.3 build 243:
  Demo model “TheVendingMachine” and the ATG Tutorial are updated.
• Bug Fixes in v2.3 build 243:
  82639 RATG/TheVendingMachine model - An Error occurred when exporting to RTC
  81281 ATG Bug Does not find correct Sequence
  80402 Duplication of files atg_release_notes.txt, ATGBuildNo.txt
  80253 Sample CppSamples\Atg\Adms4Atg\ADMS.rpy should be corrected
  80151 ATG Test Cases Invalid
  80150 In ATG, pressing F1 or selecting help gives you: cannot find the RhapATG.HLP file
  78824 Error: cannot analyse this code

41 What's New in v2.3 build 213

• New Features in v2.3 build 213:
  None
• Enhancements in v2.3 build 213:
  None
• Bug Fixes in v2.3 build 213:
  78392 Test Generation Results are lost.
  78373 Get compile errors when generating test cases
  77621 traces have not been generated if very large numbers are needed as arguments
  77094 ATG Interface Definition Starts All Ticked
  76857 ATG dialog selects tests based on the Configuration but generates code based on
  75686 transitions should have been covered by ATG but they weren’t
  75557 if your Component names are long enough, you cannot identify any components
  75526 ATG Not covering transitions
  75519 ATG argRange Constraint not working

42 What's New in v2.2 build 176

• New Features in v2.2 build 176:
  None
• Enhancements in v2.2 build 176:
  Support of most STL templates
  Right-mouse context menu
  New interface to specify test goals
  Grouping of test goals in the ATG browser
• Bug Fixes in v2.2 build 176:
  None
43 What's New in v2.2 build 160

- New Features in v2.2 build 160:
  None
- Enhancements in v2.2 build 160:
  None
- Bug Fixes in v2.2 build 160:

  74503 the report window should start with all categorys closed
  74431 ATG Missing Classes
  74280 ATG should be available in Designer
  72843 Should be able to resize the error messages window
  72838 Test Goal Definition dialog - Blue filled lines are unintuitive, should be a check box
  72836 Test Goal Definition dialog - Class icon should indicate if it has a statechart associated with it

44 What's New in v2.1 build 148

This version of Rhapsody ATG is a Release. User Guide is not yet part of the installation. The full version will be delivered with Rhapsody 5.2 MR1.

- New Features in v2.1 build 148:
  None
- Enhancements in v2.1 build 148:
  None
- Bug Fixes:

  73967 Wrong messages on create project in RIC : "Cannot add to model unit from file ATGProfile.sbs" ATGProfile now added only to RhapsodyInCpp. Message does not appear now.

  72833 ATG - After tests completed, I try to Export SD but get ATG : Fatal Error..Abortig! Problem is fixed. SD's can be exported.

  72852 ATG Crash: File>New>Test Generation Configuration Problem is not reproduceable.

  72851 ATG: After crash, ATG folder in model is Read Only Problem is not reproduceable.

  72850 Dialog should be similar to Properties Dialog Dialog is revised.

  72849 Refresh Issues Problem fixed. This does not happen anymore.

  72848 Couldn't generate SDs from ATG for my Integration test case. Not a bug. The test goals have been reached without any input so the traces

ATG_Release_Notes.odt
don't have any message. In this case ATG doesn't create an SD. ATG build 140+ notifies the user in this case.

72846 I get a deadlock error with ATG doing an integration test on the Dishwasher
Problem is fixed.

72845 Sequence Diagrams exported from ATG are corrupted and cause crash
Problem is fixed.

72844 Some read only items are not greyed out on Interface Definition dialog
Problem is fixed.

72842 The instance number column has no header
There is no need for the header, the intent is to be similar to Rhapsody
properties sheet.

72840 Refresh problems in ATG interface
Problem fixed. This does not happen anymore.

72838 Test Goal Definition dialog - Blue filled lines are unintuitive, should be a check box
Closed.

72837 ATG: Sometimes the atgComponent stereotype is not available, eg:
samples>Dishwsher>EXE

While generating new models, stereotypes are automatically added to the model.

In order to provide these stereotypes to already EXISTING models, do the following
1. File->AddToModel...
2. go to <rhapsody>\Share\Profiles\Atg
3. add ATGProfile.sbs
4. add TestingProfile.sbs

72835 Resizing ATG window causes crash
Problem is not reproduceable.

72831 ATG in 5.2 finds 5.0 installation directory as default location
Happens only if users install 5.0 after 5.2. ATG takes the settings from the registry for
the installation. Registry keys are set by Rhapsody installer.

Note:
When re-using an existing model, use the rhapsody Tools->Add to model feature to add the
TestingProfile.sbs and ATGProfile.sbs which are installed in the directory
<Rhapsody-Installdir>\Share\Profiles\ATG. Also, set the stereotype of the selected component to
'atgComponent'. Then press File->Update Testing Component in the ATG UI.

45 What's New in v2.1 build 117

---------------------------
• New Features in v2.1 build 117:
  Bug fixes.
• Enhancements in v2.1 build 117:
46 What's New in v2.1 build 109

- New Features in v2.1 build 109:
  Bug fixes.
- Enhancements in v2.1 build 109:
  ATG allows to set Code coverage goals in the Test Goal Definition tab.

47 What's New in v2.1 build 108

- New Features in v2.1 build 108:
  Bug fixes.
- Enhancements in v2.1 build 108:
  Return values are added to the sequence diagrams.

48 What's New in v2.1 build 98

- New Features in v2.1 build 98:
  Bug fixes
- Enhancements in v2.1 build 98:
  None.

49 What's New in v2.1 build 86

- New Features in v2.1 build 86:
  Feature to add a testing component. File->New->Testing Component
  Feature to delete a testing component. Edit->Delete
  Test Definition Report in Text and HTML formats
  Test Case Generation Report in Text and HTML formats
  Context menu support on Test Goal Definition tab
  'Reset Selected Test Goal Definition',
  'Set Selected Test Goal Definition' and
  'Apply Selected Package for all Packages'
  'Model Interface specification' on the General tab at component level
  ATG profiles and stereotypes are created when you start a new model
  (see the notes section for already existing models)
- Enhancements in v2.1 build 86:
  None.
50 What's New in v2.1 build 79
---------------------------------------------
• New Features in v2.1 build 79: None.
• Enhancements in v2.1 build 79: None.

51 What's New in v2.0 build 74
---------------------------------------------
• New Features in v2.0 build 74: None.
• Enhancements in v2.0 build 74: None.

52 What's New in v2.0 build 68
---------------------------------------------
• New Features in v2.0 build 68: None.
• Enhancements in v2.0 build 68: None.

53 What's New in v2.0 build 67
---------------------------------------------
• New Features in v2.0 build 67: None.
• Enhancements in v2.0 build 67: None.

Note:
If users exit Rhapsody after Generate SDs has been applied, then the rhapsody.exe process will still be active in the process list of the operating system (check Task Manager -> Processes). In order to re-launch Rhapsody, this process has to be killed manually. Subsequent versions of ATG will relax this limitation.

54 What's New in v2.0 build 66
---------------------------------------------
• New Features in v2.0 build 66:
  Export to TesConductor where the exported test data can be executed in TesConductor.
  Export and Run feature where ATG exports and runs the exported tests.
• Enhancements in v2.0 build 66:
  None

Note:
if users exit Rhapsody after Generate SDs has been applied, then the rhapsody.exe process will still be active in the process list of the operating system (check Task Manager -> Processes). In order to re-launch Rhapsody, this process has to be killed manually. Subsequent versions of ATG will relax this limitation.

55 What's New in v2.0 build 63

• New Features in v2.0 build 63:
  None
• Enhancements in v2.0 build 63:
  None

Note:
if users exit Rhapsody after Generate SDs has been applied, then the rhapsody.exe process will still be active in the process list of the operating system (check Task Manager -> Processes). In order to re-launch Rhapsody, this process has to be killed manually. Subsequent versions of ATG will relax this limitation.

56 What's New in v1.5 build 39

• New Features in v1.5 build 39:
  New Gui.
  We can now select the SDs that we want to export.
• Enhancements in v1.5 build 39:

Note:
if users exit Rhapsody after Generate SDs has been applied, then the rhapsody.exe process will still be active in the process list of the operating system (check Task Manager -> Processes). In order to re-launch Rhapsody, this process has to be killed manually. Subsequent versions of ATG will relax this limitation.

57 What's New in v1.1 build 27

• New Features in v1.1 build 27:
  New test generation goals:
  - transition coverage
  - operation call coverage
  - event generation coverage
  TestConductor integration: users can launch TestConductor from the ATG UI
• Enhancements in v1.1 build 27:
Test generation reports contain much more details. "Generate SDs" offers a selection mechanism for the test case export.

**Note:**
every single generated SD will be opened in a new editor. This means that the user has to close all generated SD editors manually afterwards. Alternatively, the user can close and re-open the project without saving the generated SDs. It is recommended to generate only a small set of SDs. Subsequent versions of ATG will relax this limitation.

**Note:**
if users exit Rhapsody after Generate SDs has been applied, then the rhapsody.exe process will still be active in the process list of the operating system (check Task Manager -> Processes). In order to re-launch Rhapsody, this process has to be killed manually. Subsequent versions of ATG will relax this limitation.

### 58 What's New in v1.0 build 20

- **New Features in v1.0 build 20:** None.
- **Enhancements in v1.0 build 20:** Patch for visual studio .net version.

### 59 What's New in v1.0 build 19

- **New Features in v1.0 build 19:** None.
- **Enhancements in v1.0 build 19:**
  States and transitions of statecharts are now considered as test goals. Test result reports contain much more details.

### 60 What's New in v1.0

- **New Features in v1.0:** Rhapsody ATG v1.0 is the first Release.

### 61 Documentation:

The Rhapsody ATG tutorial is installed in `<Rhapsody-Installdir>\Doc\html_docs\ATGTUTORIAL`. The Rhapsody ATG user guide is installed in `<Rhapsody-Installdir>\Doc\html_docs\ATGUSERGUIDE`. 
62 Samples:

A sample “Calculator_ATG_Tutorial” to be used in the ATG tutorial is part of the installation (directory <Rhapsody-Installdir>\Samples\CppSamples\Atg\Calculator_ATG_Tutorial).

63 Supported Platforms and Hardware/Software Requirements

- Supported Host Platforms:
  Rhapsody ATG version 3.8.1 runs on the following host platforms:
  - Windows 7 SP 1
  - Windows 8.1
- Supported Development Environment:
  - Rhapsody in C++ 8.1.1
  - Visual Studio 2008
  - Visual Studio 2010
  - Rhapsody ATG does not support Visual Studio 2012.
  - Cygwin 32 bit g++

64 Hardware/Software Requirements:

Refer to the HW/SW requirements as listed in the release notes of the Rhapsody 8.1.1 release. ATG requires as minimum 1 GB main memory.

65 Supported Rhapsody Version

Rhapsody ATG supports testing of UML or SysML models developed with Rhapsody in C++ 8.1.1 release using the OXF framework.

66 Training

IBM offers training on Rhapsody, UML, Rhapsody TestConductor, Rhapsody ATG and related topics. This training is offered either at IBM own facilities or at the customer site.